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Æ	1 Formulae, replication and referencing
A spreadsheet is a type of electronic document used to store data and 
information. The data can be used to perform calculations, analyse 
trends, model different scenarios and produce graphs and charts.

The main elements of a spreadsheet
A spreadsheet consists of a grid of cells.
A cell is a box on a spreadsheet into  
which you can place numbers, text  
or calculations. A spreadsheet  
is divided into rows and columns  
and these are used to provide each  
cell with a unique cell reference.
For example, the unique cell  
reference for cell B2 tells us the cell is in column B and row 2.

Writing formulae using cell references
Spreadsheets are often used to perform calculations. This is done 
by writing a formula. Most formulae use cell references. This means 
that you can change a value in a cell and the formula automatically 
recalculates the answer.
Formulae must always start with an equals sign, for example: =A1+B2.
The following operators are used to write formulae:

plus sign + for addition
minus sign − for subtraction
asterisk * for multiplication
forward slash ⁄ for division

Introducing spreadsheets
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Introducing spreadsheets
Spreadsheets are 
incredibly useful and 
powerful tools. They 
are used every day by 
people in all sorts of ways, 
from storing information 
about products and stock 
levels to managing multi-
million-pound budgets. 
They can be used to store 
data, perform complex 
calculations and to create 
graphs and charts. They 
are often used to model 
what might happen in 
different situations. This 
chapter is focused on using 
spreadsheets efficiently 
and effectively to perform 
a range of activities.

Basic formulae
Look at this 
spreadsheet and 
write formulae for 
column D to work 
out the sums. The 
first one has been 
done for you.

Replicating data and data series
Replication is where you copy information from one cell to another using 
the fill handle. This is a great time-saving feature of spreadsheets.
Click on the cell you want to replicate and move the cursor down to the 
bottom right of the cell. The cursor should change from a white cross to 

Column B

Cell B2

Row 2
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19

a black cross; this is the fill handle. Now click, hold 
and drag down over the cells you want to fill.

The fill handle can also be used to extend and 
complete a series of numbers, dates or formulae if 
you enter the first couple of items in a series:

Relative and absolute cell references
When you replicate cells with formulae in, you have 
two options. You can use relative cell references or 
absolute cell references.

Relative cell references are used when you want 
the formula to change to match the row or column it 
applies to, across several columns or rows of data; 
for example: =A1+B1.

An absolute cell reference is used when you do not 
want a cell reference to change when replicating 
cells. An absolute reference is created by adding a 
dollar sign ($) in front of the column reference, the 
row reference, or both; for example: =$A$1+$B$1.

1 Formulae, replication and referencing

Any times table
Look at the following spreadsheet.

1 Write a formula with absolute cell references 
to copy the multiplier in cell G9 to cells C7 
to C11.

2 Write formulae with relative cell references 
for column E.

3 Think about what happens to the values in 
column E when the multiplier changes.

Cell references
The table below gives the cost of different 
coloured pencils.

1 Write formulae for column D to calculate the 
cost of the coloured pencils.

2 Write formulae for column E using an 
absolute cell reference, to calculate the cost 
of the coloured pencils plus delivery. 

3 Write a formula for cell E22 to calculate the 
total cost of all the pencils, plus one delivery 
charge.

Checking in
➊ What is replication? Describe how you would 

use replication to extend and complete a 
series of numbers.

➋ Explain what is meant by a relative cell 
reference.

➌ Explain what is meant by an absolute cell 
reference.
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Functions
Functions are pre-programmed into spreadsheets. 
They allow us to perform longer or more complex 
calculations with ease. The following formulae 
both perform the same calculation, but the second 
formula, which makes use of a function, is shorter 
and mistakes are less likely when typing it.

=A3+B3+C3+D3+E3+F3+G3  
=SUM(A3:G3)

All functions start with an equals sign followed by 
the function name.

The data to be used by the function is referenced 
using individual cell references or a cell range 
enclosed within parentheses ( ); for example:

=SUM(A3:G3).

The SUM function
The SUM function adds up the values in a range 
of cells.

To add up the total score for the group use the 
formula =SUM(B4:B7).

Function name Cell range

Æ	2 Functions using SUM, AVERAGE, MAX and MIN
The AVERAGE function
The AVERAGE function works in much the same way 
as the SUM function.

To work out the average mark use the formula 
=AVERAGE(B4:B7).

The MAX and MIN functions
To find the largest value in a range, use the MAX 
function. To find the smallest value in a range, use 
the MIN function.

The highest exam mark is found using the formula 
=MAX(B4:B7). The lowest exam mark is found 
using the formula =MIN(B4:B7).

Introducing spreadsheets
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2 Functions using SUM, AVERAGE, MAX and MIN

Cinema tickets

Look at this spreadsheet. It shows the weekly ticket 
sales for various films at a cinema.

1 Write functions for column I to calculate the total 
weekly sales for each film.

2 Write functions for row 18 to calculate the 
average ticket sales each day.

3 Write formulae for the shaded cells in column F 
to work out the answers to the questions.

Checking in
➊ Give an example of a cell range.

➋ Why would you use the SUM function rather 
than writing a formula?

➌ Which function would you use to find the 
largest value in a set of data?
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Introducing spreadsheets

The IF function
The IF function is used to make choices. It has the 
following structure: 

=IF( Question, Do this if True,  
Do this if False ).

There are three elements that need to be included 
inside the parentheses and they are separated by 
commas.

1 A question: this is a logical test or logical 
expression to which the answer can be either 
True or False.

2 What is to happen or be displayed if the outcome 
of the logical test, or ‘condition’, is True.

3 What is to happen or be displayed if the outcome 
of the logical test, or ‘condition’, is False.

The logical test in an IF function uses Boolean 
operators:

> greater than

< less than

= equal to

>= greater than or equal to

<= less than or equal to

<> not equal to

Here is an example of an IF function that tells you 
if a student has passed or failed a test with a pass 
mark of 60.

Æ	3 Boolean operators and the IF and COUNT functions
The COUNTIF function
The COUNTIF function counts the number of cells  
in a selected range that meet a specific criterion.  
It has the following structure: 

=COUNTIF( Range, Criterion ).

The range selects the cells to be checked and the 
criterion is the condition that determines which cells 
will be counted. It can be a number, a mathematical 
expression or text that needs to be matched.

Here is an example of a COUNTIF function that 
counts how many students got a B-:

Test marks
Look at the following spreadsheet. It gives the 
marks achieved by students in three tests.

1 Write formulae for column E to calculate the 
total of the three test marks.

2 Write IF functions for column F to decide 
whether each student has passed or failed. 
Use absolute cell references.

3 Write functions in the green cells to count the 
number of students who have passed and failed.

Logical test

Value to be returned if the condition is True

Value to be returned if
the condition is False
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3 Boolean operators and the IF and COUNT functions

The COUNT and COUNTA functions
The COUNT function counts the number of cells in a 
selected range that contain a number.

Here is an example of a COUNT function. The answer 
is 4, because cells B2 to B5 all contain numbers.

Checking in
➊ What are the three elements needed to write 

an IF function?

➋ What does the COUNT function tell you?

➌ Which function would you use to find out how 
many cells in a range contain a specific value?

Ifcity Zoo
Open the Ifcity Zoo spreadsheet. It lists 
the different species of animal found at 
Ifcity Zoo.

1 Write a function in column D to calculate 
the total number of each type of animal.

2 Write an IF function in column H to  
work out each animal’s popularity. If 
they have more than 30 visitors per 
hour they are ‘Popular’. Otherwise, they 
are ‘Standard’.

3 Write COUNTIF functions in cells B36 to 
B39 to calculate the number of different 
species for each type of habitat.

4 Write COUNTIF functions in cells B42 to 
B44 to calculate the number of different 
species for each conservation status.

5 Write a COUNTA function in cell G35 to calculate 
the number of different species at the zoo and 
a COUNT function in cell G36 to calculate the 
number of different species at the zoo with 
young.

6 Write COUNTIF functions in cells G38 and G39 
to calculate the number of ‘Popular’ species 
and the number of ‘Standard’ species.

7 Write functions in cells G41 and G42 to 
determine the most visitors per hour and the 
least visitors per hour for any species.

The COUNTA function counts the number of cells 
in a selected range that contain a value (text or a 
number).

Here is an example of a COUNTA function. The 
answer is 3 because cells B2, B4 and B5 contain a 
value.
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Introducing spreadsheets

Formatting cells
Formatting cells helps to make a spreadsheet 
easier to read. You can change the:

� font, text size and text colour

� fill colour

� number format

� text alignment

� border.

You can format cells using the tools in the ribbon on 
the Home tab.

Æ	4 Formatting, graphs and charts

Conditional formatting
Conditional formatting allows you to alter the 
appearance of a cell depending on the value it 
contains. This enables you to quickly identify 
patterns in your data. For example, in the below 
spreadsheet, conditional formatting has been 
applied to column C so that any cell containing 
a number greater than 10 has a green fill and 
any cell containing a number less than 8 has a 
red fill.

You can apply conditional formatting by selecting 
‘Conditional Formatting’ and ‘Highlight Cells Rules’ 
from the ‘Home’ tab.

Formatting practice
Recreate this spreadsheet, with all the formatting 
shown. Can you make your spreadsheet look 
exactly like the screenshot?

Picture
Create the following spreadsheet and add 
conditional formatting to reveal a picture. The 
key tells you the fill colours to use for different 
cell values.

Remember to select all of the cells in the grid 
before applying each conditional formatting 
rule.

323452_02_Pro_Com_KS3_018-029.indd Page 24  4/28/21  6:04 PM f-0236-new /107/HO02104/work/indd

Copyright: Sample material



25

4 Formatting, graphs and charts

Graphs and charts
Graphs and charts give a visual representation of 
data and presenting data in graphs or charts can 
make data easier to understand or interpret.

There are several different types of graph and 
chart and each is designed to display different 
types of data.

�	Bar charts and column charts allow you to 
compare categories of data that are not  
directly related to identify similarities and 
differences.

�	A pie chart shows the individual parts that make 
up a whole. They are useful to show percentages.

�	Line graphs are used when you want to show 
how something has changed over time. They are 
useful for plotting the results of experiments.

To create a graph or chart, select the data on 
the spreadsheet, go to the ‘Insert’ tab and then 
choose the type of chart you require from the 
‘Recommended Charts’ drop-down list.

Temperature
Copy the data in the table below into a 
spreadsheet and use the data to insert a 
clustered column chart to show the temperature 
across the year. Make sure your chart includes a 
suitable title and labels for each axis.

Month Temperature (°C)
Jan 6

Feb 8

Mar 12

Apr 13

May 17

Jun 21

Jul 25

Aug 22

Sep 15

Oct 10

Nov 6

Dec 1

Height
Copy the data in the table below into a 
spreadsheet and use the data to insert a line 
graph to show a person’s height compared 
to their age. Make sure your chart includes a 
suitable title and labels for each axis.

Age (years) Height (cm)
0 45

1 68

2 85

3 94

4 101

5 108

6 115

7 121

8 127

9 133

10 138

11 144

12 151

13 157

14 160

15 162

16 163

Checking in
➊ Identify three ways in which the appearance 

of a cell could be formatted.

➋ When might we use conditional formatting?

➌ What chart should we use to show the 
percentage of students in the class who own 
a pet?
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Introducing spreadsheets

Using spreadsheets for modelling
Modelling allows us to predict what is likely to 
happen when something changes. It is used for 
many different purpose, for example, for weather 
forecasting, to predict what the weather will be like 
in the future.

Modelling is also used in financial decision making 
to work out, for example, how much profit will be 
made if prices change. It is also used by engineers 
designing roller coasters to work out, for example, 
how variations in the design will affect the speed of 
the roller coaster.

Spreadsheets are excellent for modelling because 
it is easy to set them up and perform calculations 
on data. It is also possible to try out lots of different 
scenarios to find the best result.

Goal Seek
Goal Seek is a spreadsheet tool that allows you to 
see how changing one value in a formula affects 
another. It enables you to ask ‘what-if’ questions to 
achieve a specific goal. For example, you can use it 
to find out the price you need to sell an item for to 
make a certain amount of profit.

To use Goal Seek, go to the ‘Data’ tab, click on  
‘What-If Analysis’ and select ‘Goal Seek …’ .

Æ	5 Modelling

Sweet shop
This spreadsheet allows us to set a budget (in 
this case, £5) and then model how we can best 
spend the money to buy a wide range of different 
sweets.

Look at the spreadsheet.

1 Think about how to format cells D13 to D21, 
cell D23 and cell D25 as currency.

2 Write formulae for column D to calculate the 
cost of whatever quantities of sweets are 
entered into column C.

3 Write a function for cell D21 to calculate the 
total cost of all the sweets selected.

4 Write a formula for cell D23 to calculate the 
budget remaining, by subtracting the total cost 
from the budget amount.

5 Think about how to add conditional formatting 
to cell D21 so that the background colour is 
green if the total is less than or equal to the 
budget amount and red if the total is more 
than the budget amount.

6 Think about how you would use Goal Seek to 
work out how many grams of Jelly Snakes you 
can buy for your budget. In Microsoft Excel, 
you need to open the Goal Seek dialogue 
box, enter D21 in the ‘Set cell’ box, 0 in the ‘To 
value’ box because you want your budget to 
end up at zero, and C15 in the ‘By changing 
cell’ box.
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5 Modelling

Cupcake challenge
You have decided to hold a charity cake sale. You 
are going to use the cake and icing recipes below 
to make 12 cupcakes.

Open the Cupcake challenge spreadsheet and 
then follow the instructions below.

1 Enter a formula in cell E14 to calculate the cost 
of 1 g of butter. Replicate this down to cell E20 to 
calculate the unit cost of the other ingredients. 
Make sure the cells are all formatted as 
currency. Note that the cell value will show 
£0.00 if the cost of 1 g or 1 ml of the ingredient is 
less than 1p.

2 Enter a formula in cell E24 to calculate the 
cost of the butter needed for the cake recipe, 
making sure the cell is formatted as currency. 
Then enter similar formulae in cells E25 to E28 
to calculate the cost of the other ingredients 
needed for the cake recipe, again making sure 
the cells are formatted as currency.

3 Enter similar formulae in cells E32 to E35 to 
calculate the cost of the ingredients needed for  
the icing recipe. Make sure the cells are 
formatted as currency.

4 Enter a function in cell C37 to calculate the total 
cost of the ingredients needed to make 12 iced 
cupcakes.

5 Enter a formula in cell C39 to calculate the total 
cost of the ingredients needed to make one iced 
cupcake.

You now want to work out how much profit you will 
make if you sell each cupcake for 50p.

6 Enter the number of cupcakes sold (12) into cell 
C49 and the selling price (50p) into cell C51.

7 Enter a formula in cell C53 to calculate the 
profit/loss per cupcake. You will need to 
subtract the cost price per cupcake from the 
selling price.

8 Enter a formula in cell C55 to calculate the total 
profit/loss for the number of cupcakes sold. Add 
conditional formatting to cell C55 so that the fill 
colour is light green if there is a profit, and pale 
red if there is a loss.

9 Use Goal Seek to work out how many cupcakes 
you will need to sell if you want to make £25 
profit for charity. Enter the number of cupcakes 
in cell D59.

Checking in
➊ What is meant by modelling?

➋ Why are spreadsheets good to use for modelling?

➌ What does Goal Seek enable you to do?
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Introducing spreadsheets

Æ	6 Theme park challenges

Theme park challenge 1
You have been engaged by a 
local theme park to help them 
calculate their costs and ticket 
prices. The theme park is open 
365 days per year, for 8 hours per 
day.

Open the Theme park challenge 
spreadsheet, which contains data 
about the rides that you will need 
to complete the activity.

1 Enter a formula in cell C31 to 
calculate how many minutes 
the park is open each day.

2 Enter a formula in column E to 
calculate the number of times 
each ride runs per day. Each 
run takes the length of the ride 
plus 2 minutes for changeover. 
Use absolute cell references 
to link to the park opening time 
per day and the time between 
each ride in your formula.

3 Enter a formula in column F to 
calculate the total number of 
guests who can go on each ride 
in a day.

4 Enter a formula in column G to 
calculate the cost of operating 
each ride for one day. This 
is the total number of guests 
multiplied by the thrill factor 
multiplied by the cost per ride 
(50p). Make sure that the cells 
are correctly formatted as 
currency.

5 Enter a function to work out the 
total cost of operating all the 
rides for one day.

6 Format the table so that the 
column headings are bold, use 
a font size of 14pt and have a 
light grey fill colour.
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The Theme Park usually has 5000 guests per 
day and the entrance ticket costs £15. As well as 
the cost of the entrance ticket, each guest spends 
an additional £5 on food and drink.

7 Format cells C48, C50, C52, C54, C56, C58 
and C62 as currency.

8 Enter a formula in cell C52 to work out the 
total income each day.

9 As well as the cost of running the rides, the 
theme park has staffing costs each day 
(£7500). Enter a formula in cell C56 to work 
out the total expenditure each day.

10 Enter a formula in cell C58 to work out how 
much profit the park will make each day. 
This is the total income minus the total 
expenditure.

11 Add conditional formatting to cell C58 so that 
the background fill is light red if the profit is 
less than £50,000 and light green if it is higher 
than £50,000.

12 Work out the ideal ticket price the theme park 
should charge if it wants to make £75,000 
profit per day. Enter the figure in cell C62.

The theme park is creating some new publicity 
materials. It would like to include a chart to show 
what percentage of rides have each thrill factor.

13 Use functions to count how many rides there 
are for each thrill factor (cells B69 to B73).

14 Insert a suitable chart to show the percentage 
of rides for each thrill factor. Make sure that 
the chart has a suitable heading and shows 
the percentage of rides for each thrill factor.

Theme park challenge 2
Now that you have completed the main theme 
park challenge, use your knowledge and skills 
to model some new situations and answer the 
following questions.

1 The number of guests per day increases to 
6,000. If the ticket price is £15, how much profit 
will the park make each day?

The cost per ride increases to 75p.

2 If the ticket price is £15 and there are 6,000 
guests, how much profit will the park make  
each day?

3 If the income from food/drink per guest 
decreases to £4.25, how much profit will the 
park now make each day?

4 What should the park change the ticket price 
to in order to make £65,000 profit each day?

5 A new queueing system allows the time 
between each ride to decrease to 90 seconds.  
If the cost per ride is 55p, how much will it cost 
to operate all the rides for one day?

Checking in
➊ Name three things you now know how to do 

on a spreadsheet.

➋ Describe the three things you now know how 
to do on a spreadsheet.

6 Theme park challenges
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Glossary
absolute cell reference a cell reference that does not 
change when it is replicated to several columns or rows 
of data in a spreadsheet, for example, =$A$1+$B$1
abstraction removing unnecessary and unhelpful detail; 
one of the cornerstones of computational thinking
acceptable use policy the rules that govern how a 
computer network should be used
action the output if the condition is met
algorithm a series of simple, logical, step-by-step 
instructions that must be followed in a strict sequence
algorithm design planning a solution based on your 
understanding of the problem; one of the cornerstones of 
computational thinking
AND a logical operator that allows for two conditions to 
be checked; for it to return True, both conditions must be 
true
AND in spreadsheets, the AND logical operator can 
be used in IF functions to check that more than one 
condition is True
AND gate a logic gate that requires both condition 1 
AND condition 2 to be met for the gate to open
anti-malware software scans computer programs and 
emails for malicious code and puts anything suspicious 
in quarantine; also referred to as anti-virus software
app a computer program/piece of software; short for 
‘application’
arrange to organise sounds according to your audio 
timeline
ASCII The American Standard Code for Information 
Interchange was invented to standardise the denary 
numbers assigned to each character on a keyboard
attribute a characteristic. The attributes of a vector 
graphic include its height, width, outline colour and 
fill colour. An attribute is also the information that is 
included inside an HTML tag, for example, the src and alt 
attributes must be included inside the <img> tag
Audacity a free Digital Audio Workstation (DAW)
audio effect something that is used to enhance or 
process audio, to make it sound different; there are four 
main audio effects: fade in/fade out, reverb, compression 
and envelope
avatar a profile picture on social media
AVERAGE in spreadsheets, this function calculates the 
mean of the values in a range of cells
bar charts allow you to compare categories of data that 
are not directly related in order to identify similarities and 
differences
base 10 the number system that uses ten digits: 0, 1, 2, 3, 
4, 5, 6, 7, 8 and 9; also known as the decimal system or 
the denary system
base 2 the number system that uses just two digits: 0 
and 1; also known as the binary system

binary system the number system that uses just two 
digits: 0 and 1; also known as base 2
bit each 1 and 0 in a binary number is known as a bit
bitmap graphic data about an image is stored by a 
computer as pixels; also known as a raster graphic
Boolean operators logical tests in Python use the 
following Boolean operators:
< less than
<= less than or equal to
!= not equal to
== equal to
> greater than
>= greater than or equal to
Boolean value a value that can be only True or False
Boolean variable a variable that is only True or False
border a line around the outside of an element creating 
a box
brute force attack using a program that tries every 
possible combination of letters, numbers and special 
characters to identify your password
bug an error in a computer program
button in spreadsheets, macros are assigned to buttons
byte unit of storage; other units of storage include 
bit (there are 8 bits in a byte), kilobyte (1000 bytes), 
megabyte (1,000,000 bytes), gigabyte (1,000,000,000 
bytes), terabyte (1,000,000,000,000 bytes) and petabyte 
(1,000,000,000,000,000 bytes) 
casting declaring what data type a variable will be
cell a box on the spreadsheet, into which you can place 
numbers, text or calculations
cell range two or more cells next to each other in a row 
or a column in a spreadsheet, for example, A1:A10
cell reference a unique reference used to identify a 
cell in a spreadsheet. Cell references can be relative, 
for example, =A1+B1, or absolute, for example, 
=$A$1+$B$1
check box a type of form control that allows the user to 
select one or more items from a range of options; also 
known as a tick box
cipher an encryption algorithm
ciphertext in encryption, the encrypted message is in 
ciphertext
clock speed how many fetch–decode–execute cycles 
a CPU can process per second; often referred to as just 
‘speed’
cloud computing data is stored online and software 
is used via an internet browser, rather than being stored 
locally on a computer’s hard drive
column a spreadsheet is divided into rows and columns
column charts allow you to compare categories of data 
that are not directly related in order to identify similarities 
and differences

323452_Glo_Pro_Com_KS3_209-215.indd Page 209  4/28/21  4:37 PM elhiddn ~/Desktop/Arun%20Bhatnagar/HO02104:107/CHAPTER

Copyright: Sample material



Progress in Computing: Key Stage 3 Boost

Reboot your Key Stage 3 classroom with this flexible and interactive toolkit that includes 
everything you need to deliver inspiring and creative Computing lessons with confidence.

Across 16 modules, with Progress in Computing you can:

● Track and demonstrate progress with ease: the Progression Pathway maps progression 
throughout the course, across a Baseline Assessment, 16 end-of-module assessments, more 
than 100 auto-marked homework quizzes, interactive coding challenges and three end-of-
course projects.
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own, using our course planner and resources, all of which are tagged to National Curriculum 
statements and Key Stage 4 specifications.

● Bolster your existing teaching toolkit: the more than 100 lesson presentations, 150 
worksheets, 100 videos/animations and sound and video files can be easily integrated with 
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